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Mastering focus & 
controlling depth-of-
field are hands down the most 
important skills you’ll learn as a 
creative photographer. Fact. the 
ability to choose and control what is 
in and out of focus in an image is what 
separates considered pictures from snapshots – and it’s 
one of the easiest ways to mark out professional looking 
photos from more naïve compositions. 

in this guide you’ll learn how to take control of focusing 
and use it to your advantage, so whether you want to 
reproduce pro-style narrow depth-of-field effects or 
retain pin-sharp detail throughout the frame we’ve got 
you covered. 

If you want to get the best 
from your D-SLR and produce 
top-quality shots, you need 
to master focusing & depth-
of-field – just follow this 
simple guide to find out how! 

see how easy it is to master 
aperture  over the page

Master 
focusing 
effects
... but by controlling 
simple camera 
settings like 
aperture and 
autofocus you can 
produce pro-style 
pics with any  
d-slr and lens!

don’t 
shoot the 
lazy way!
if you don’t harness 
depth-of-field 
control, you’ll 
always end up with 
so-so pictures...

3

all new d-slr 
& photoshop 
skills!

use  your camera  like you really should!

set up  

your  

d-slr for 

creative 

photo 

effects!
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a picture’s depth-of-field is best 
defined as the amount of it that 
is acceptably sharp – anything 
outside of this area is considered 
to be unsharp and therefore 
outside the depth-of-field.

 so, if you were looking at a 
landscape where everything 
from the details in the 

foreground to the distant 
scenery was sharp, it would be 
said to have  a very large 
depth-of-field. on the other 
hand, if you were looking at a 
portrait or a still-life picture 
where only the subject was in 
focus and the background was 
fuzzy and diffused, that would be 

said to have a very small, or 
shallow depth-of-field. 

there are several factors which 
control how much depth-of-field 
is present in your shots and which 
parts of the picture are sharp – 
the aperture (the ‘hole’ in your 
lens that’s described by an  
f/number), the focal length you’re 

shooting at and point at which 
you’ve focused – all of which we’ll  
cover in the following pages. 

it’s learning how to utilise these 
techniques and knowing where 
and when to use them that’s the 
key to controlling focus and 
depth-of-field, and ultimately 
getting successful pictures.
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get creative with focustecHnique
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wHat you need any D-slr & kit lens 
wHat you’ll learn how aperture relates to Depth-of-fielD
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what is depth-of-field?

apertures & depth-of-field in action

picking the right aperture
Here’s a rough guide to how the depth-of-field generated by different apertures can be put to good use 
and which subjects are appropriate for them. of course, rules are made to be broken, but if you’re new 
to controlling focus and depth-of-field creatively, this is a good place to start...

expert advice

knowledge

wide apertures let in a lot of light, increase 
the shutter speed and allow any parts of the 
scene away from the point of focus to blur 
very quickly. this means they’re great for 
action, wildlife and portrait photography, 
but require careful focusing.

smaller apertures give a large depth-of-field 
so they’re great for ensuring front-to-back 
sharpness in landscape shots. because the 
hole in the lens is so small though, diffraction 
of light can occur, so though the depth-of-field 
is greater, image quality can suffer.

due to the way they’re constructed, the 
optics of a lens will tend to produce their 
sharpest results at the middle apertures, so 
setting the lens within this range is helpful 
when detail is paramount, as in product 
photos and still-life images.

Aperture f/2.8 Aperture f/5.6 Aperture f/11 Aperture f/1 6 Aperture f/22

the easiest way to understand how the 
aperture you set dictates your picture’s 
depth-of-field is to focus on a subject fairly 
close to the lens, then take a few shots of 
it, decreasing the aperture (increasing the 
f/number) each time you hit the shutter. 
you’ll quickly see how the background gets 
sharper the smaller the aperture you use... 

how aperture 
affects what’s 
in focus
the larger the aperture you set 
when shooting, the narrower 
the depth-of-field in your 
picture will be and the smaller 
amount of it will be in focus. 

Aperture f/22 large depth-of-field

focus point

medium depth-of-fieldAperture f/11

Aperture f/2.8  narrow depth-of-field

f/5.6 and below f/8 to f/1 1 f/16 and above

start getting  the best from your d-slr & lenses!

you  can master  this vital skill  now!
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wHat you need any D-slr & kit lens 
wHat you’ll learn how focusing affects Depth-of-fielD
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three ways to focus 
your d-slr better

turn the 
page for 
practical 
projects!

getting the depth-of-field you want isn’t just about setting the 
correct aperture – where and how you focus is really important, too. 
Here are some of the easiest ways to improve your focusing and get 
perfect sharpness right where you want it in your pictures…

now you’ve got a good 
understanding of 
depth-of-field it’s time 
to get practical. there 
are four great camera 
and software 
techniques on the 
following pages that 
will help you achieve 
everything from 
perfect shallow- 
focus effects to the 
ultimate in front-to-
back sharpness!

expert advice

pick the right Mode
set your af mode according to the 
subject you’re shooting and you’ll have a 
much better chance of getting the 
depth-of-field in the right place. single 
(one shot or s-af) is perfect for portraits 
and landscapes, while continuous (c-af 
or ai servo) will help you track fast-
moving subjects, so it’s great for sports 
and wildlife. finally, manual is by far the 
best option for controlling focus for 
macro or still-life subjects (especially in 
conjunction with live View – see right). 

use live view
most photographers favour composing via 
the viewfinder and see live View as the 
domain of compacts, but it can be 
incredibly useful when focusing manually. 
on screen you’ll get a perfect preview of 
where the focus is falling and you can zoom 
in for even more clarity.

change your af point
most d-slrs have at least five af points, so it 
makes sense to use them! changing the active 
af point so that it covers the part of the scene 
which you want to be sharpest will save you 
from having to lock the focus and recompose 
– something that can spoil critical sharpness 
when working with a very shallow depth-of-
field. changing your af point varies from 
camera to camera, but most enthusiast models 
will have an af selector button on the rear. 
press this, then use the d-pad, thumb stick or 
similar to cycle through the af points available. 

once you’ve decided on the amount of 
depth-of-field you want in your shot and 
therefore which aperture to use, you need 
to think about where to focus and how to 
frame the subject. the point at which you 
focus in your shot will make an enormous 
difference to how and where the 
depth-of-field is generated and therefore 
which parts of the shot look sharp. 

this is particularly critical when using 
very wide apertures that generate a 
shallow plane of sharp focus. For instance,   
if you’re using a fast aperture like f/2.8 and 
focusing on a subject that’s only about six 
feet away, the depth-of-field can be just a 
few centimetres. that means careful 
focusing is important – it’s the difference 
between getting the eyes in a portrait 
sharp or missing those vital details. 

another way that depth-of-field is 
affected is in how close to the lens you 
focus – the closer you focus, the easier it 
will be to generate a shallow depth-of-field. 
conversely, close focusing makes getting 
front to back sharpness more difficult, but 
there are ways to work around this, such as 
focus stacking which you can read more 
about on page 12. 

fraMing & focusing for 
perfect depth-of-field

“ Careful focusing is important if you 
want those vital details ”

iMprove the look of 
defocused areas
any areas that are outside of the depth-of-field in your shots will look 
blurred, but how this blur appears can be very different from one picture to 

the next – even in shots taken at the same aperture, focal length and 
on the same lens. the way that out-of-focus 

areas appear is known as bokeh 
(pronounced bo-ké), which comes from 
the Japanese word “boke”, meaning 
“blur” or “fuzziness”. 

many photographers fret about the 
shape of the bokeh (it’s said that good 

bokeh should be seen as perfectly flat discs of light), 
but there’s not much you can do about this, 

because it’s governed by the shape of the 
aperture in your lens. what’s more useful is 

knowing that if your background is dim, the 
bokeh will be quite flat, but if you shoot into 
the light, you’ll get a pleasing sparkle. 

knowledge

good & bad bokeh
both shots were taken using the same 
f/5.6 aperture on the same lens, but 
highlights in the background produce 
pleasing bokeh, while without them 
the picture looks flat and dull. 

though the same aperture has been used 
in both of these shots, framing and 
focusing make a big difference...

focusing on a subject 
further from the camera 
and at a wider focal 
length, the perceived 
depth-of-field is 
greater, even though  
on close inspection  
the background is  
still blurred. 

Aperture f/2.8, 50mm, 6ft Aperture f/2.8, 50mm, 20ft

see how easy it is to master 
aperture  over the page
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“ you’ll learn to achieve one of creative 
photography’s essential effects... ”
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this great technique 
continues over the page

this great technique 
continues over the page
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project 1

blur the 
background
The ability to get a pleasingly defocused background 
behind your subject is central in creative 
photography – learn how to do it right here! 

it’s great to have an 
understanding of the science 
behind depth-of-field, but what 
you really want to know is how to 
control focus for real using your 
d-slr! and that’s just what you’ll 
learn how to do in this tutorial, 
achieving one of creative 
photography’s essential effects – 
a picture with a nice sharp subject 
and a contrastingly fuzzy and 
defocused background. 

this technique is really easy to 
do and can be achieved on any 
digital slr or creative compact, so 

long as it has an aperture priority 
shooting mode. you certainly 
don’t need pro-spec lenses with 
super-fast apertures either, 
because we’re going to show you 
how it can be done using a d-slr 
with a variable aperture kit lens.

as you’ll have already read, 
there are several ways you can 
produce a shallow depth-of-field 
in your pictures – using low  
f/numbers, longer focal lengths 
(zooming in) and focusing close to 
the camera – all of which are used 
in this technique.

finish check the results. examine your pic on the 
screen. if the depth-of-field isn’t shallow enough, move your 
subject away from the background and towards the camera 

– this will increase the amount of blur because the background is further 
from the point of focus. Finally, zoom right in to check the sharpness on 
the subject. if the focus is off, you’ll need to reshoot. 

start set Mode & zooM. set your shooting mode to 
aperture priority (look for a or av on the mode dial, or in the 
shooting menu). next, set the aperture to its widest setting by 

changing the f/number to the lowest you can. this will vary from lens to 
lens, but anything up to f/5.6 will produce good results. next, zoom in – 
the longer the focal length the more exaggerated the effect will be.

focus & shoot. Frame up and, either in the viewfinder or via 
the camera’s screen, alter the position of your autofocus point 
so that it covers the subject. now gently squeeze the shutter 

button to shoot. if you don’t want to, or can’t move the aF point, 
half-press the shutter button to lock focus, then recompose, but don’t 
move towards or away from the subject before firing off a shot. 

2 3

1

at f/16, the background is held in too sharp a 
focus, so it becomes distracting and spoils 
what would otherwise be a pleasing portrait. 
this can happen if you leave your camera set 
to its Auto or Program mode.

digital photo 9www.photoanswers.co.uk

get creative with focustecHnique wHat you need a D-slr or creative compact 
wHat you’ll learn how to get a shallow Depth-of-fielD

aperture f/5.6

final iMage
even at f/5.6, a pleasingly 
defocused background can 
be achieved, which will make 
all the difference in your 
portrait images.
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project 2

increase the  
depth-of-field
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this great technique 
continues over the page

get creative with focustecHnique wHat you need a D-slr or creative compact 
wHat you’ll learn how to get a large Depth-of-fielD

fraMe up & focus. next, zoom out to a wide view, frame up on 
the scene and move your chosen aF point so that it covers an area 
about a third of the way into the view – this will maximise the 

depth-of-field because at wide focal lengths it extends around two thirds 
further than the focus point than towards you. using one of the aF points 
on the lower third is a good guide.

start aperture priority. set your camera’s shooting 
mode to aperture priority (a or av) using the mode dial on the body 
or the main menu. now close the aperture right down by setting 

the highest f/number (usually f/16 or f/22). now check the shutter speed 
– small apertures slow up the exposure, so you may need to increase the 
iso sensitivity to compensate if you’re handholding the camera.

finish check the sharpness. after shooting, bring the 
picture up on your camera’s screen and zoom right in on the 
foreground to check that it’s in sharp focus. do the same with the 

background. if the foreground is sharp but the background not, try focusing 
a little further into the scene. if the opposite is true, focus a little closer to 
you. that’s all there is to it! 

2

1

3

final iMage
by using small apertures 
(setting a high  
f/number), front-to-back 
detail is guaranteed.

www.photoanswers.co.uk

Shoot with a 
large depth-of-
field and enjoy 
detail from the 
foreground to 
the background

soMetiMes in your photos you’ll want everything in the 
scene to be sharp, so that objects right from the foreground through 
to those in the distance have lots of detail to enjoy. this kind of large 
depth-of-field effect is achieved in a very similar way to getting a 
shallow depth-of-field, but instead of using very large apertures, 
you need to use very small ones.  

traditionally, hyperfocal distancing was used to ensure maximum 
sharpness – a system that, based on the focal length and aperture 
you’re using, told you where you’d need to focus to get the largest 
depth-of-field. unfortunately this relies on lenses with barrel 
markings, something that modern zooms usually lack. it’s also very 
time-consuming, so here’s an easy work-around...

caMera step-by-step

digital photo 11www.photoanswers.co.uk

aperture f/22
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this great technique 
continues over the page

get creative with focustecHnique wHat you need a D-slr & photoshop or elements 
wHat you’ll learn how to focus stack your pics

Take a series of shots at different focus 
points and combine them in Photoshop or 
Elements for maximum sharpness

even with a lens stopped down to a small aperture such as f/16, it’s often impossible to 
get the image sharp all the way from the foreground through to the very far background. by 
locking off your camera on a tripod and manually focusing at different points of the frame, 
you can then blend the shots to create an image that has massive depth-of-field, with 
sharpness running from front to back. so, if you want ultimate sharpness right the way 
through your shots, read on to see how it’s done...

start coMpose. set your camera 
up on a tripod and frame your shot. 
next set your mode to manual and the 

aperture to f/11-13 for crisp results. now use 
your viewfinder’s exposure meter bar and dial 
through the shutter speeds until it’s in the 
centre of the scale. take a test shot to check 
it’s correctly exposed.  

set your focusing. with your 
camera set up ready for the shot, 
switch from autofocus to manual 

focus, so you can control the focus yourself. 
there’s often a aF/mF switch on the camera 
body or lens, though in some cases you may 
have to dive into your camera’s menu to 
change this. 

finish take a series 
of shots. now focus on 
the closest part of the shot, 

in this case the daisy, and take a shot. 
then gently twist the manual focus 
ring so the focus shifts further back 
to the middle distance and take 
another shot. to finish, focus on the 
background and take a shot. in some 
cases, you may find you need to take 
more than three shots, but once 
done, you’re ready to merge them...

1 2

3

start iMages  
stevington 1, 2, 3.jpg
by taking three shots of the same subject at 
different focus points across the frame, we can 
achieve a massive depth-of-field once we’ve 
merged them in photoshop. 

final iMage
the three merged files have created 
this one single image with a massive 
depth-of-field running from front of 
the picture to the very back. 

www.photoanswers.co.uk

caMera step-by-step

focused on  
Middle ground

focused on  
background

focused on 
foreground

aperture f/13

aperture f/13

aperture f/13

focus stack 
for ultiMate 
sharpness
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copy & paste. open up the shot focused on the middle of 
the scene and you’ll see that both the foreground and 
background are blurred. hit Ctrl+A to select the image and then 

Ctrl+C to copy it before hitting Ctrl+W to close the file. now open up the 
pic focused in the foreground and hit Ctrl+V to paste in the copied file. 
bring up your Layers palette by going to Window ➔ Layers.

finish crop the iMage. drag the left-hand arrow inwards 
until a third of the way across and hit OK. now go to Layer ➔ 
Flatten image and select the Crop tool from the toolbox. drag it 

out across the entire image and then rotate in the corner to angle the 
shot, before dragging in the corner handles so the crop doesn’t 
overshoot the image, then hit Return to confirm the change. 

darken the sky. with Layer 2 still selected, make a 
selection of the sky and then go to Select ➔ Refine Edge (or hit 
the Refine Edge button) and enter a Feather value of 130px. in 

your Layers palette, click on the Adjustment Layer icon and from the 
drop- down list, select Levels. in the pop-up box, drag the central arrow 
to the right until it meets the histogram.

8

4

6

9

5 

7
copy second layer. if you make a mistake and erase too 
much, go to Window ➔ History  (Undo History in elements) and 
click back to the State before you went wrong and continue from 

there. open up the pic focused in the background, select and copy it, 
then close the image as before. click back on the working image and 
paste in the new layer, making sure it’s at the top of the layers stack. 

repeat process. again with the Eraser tool at the same 
settings, start working in from the bottom and deleting all of the 
blurred areas at the bottom, revealing the sharp ones below.  

zoom in to make sure you don’t erase past the in-focus area and, as before, 
click back in your Undo History if you make a mistake. now go to the 
toolbox and pick the Rectangular Marquee tool. 

erase foreground. making sure Layer 1 is active, pick the 
Eraser tool from the toolbox. with a brush size of 250px and an 
Opacity of 100%, start to brush in from the bottom right-hand 

corner. keep erasing until the sharply focused parts of the scene are 
running into one another and the picture is sharp from the front through 
to the middle of the scene. 

photoshop step-by-step

get creative with focustecHnique

digital photo14 www.photoanswers.co.uk

Digital Photo magazine 
brought to life on iPad 

The Digital Photo app is designed from the ground up to 
bring a complete photography experience to your Apple iPad  

and features embedded video lessons to help you learn 
essential techniques – fast!

Available now at www.greatmagazines.co.uk/dp

> Experience the beauty of Planet 
Photo in all its glory on the iPad’s 
high resolution screen

> Learn core skills in Photoshop 
and watch video lessons  
directly within the app

> Swipe and tap your way 
through the magazine with its 
plethora of interactive features
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project 4

digital photo16 digital photo 17www.photoanswers.co.uk

this great technique 
continues over the page

get creative with focustecHnique wHat you need photoshop or elements 
wHat you’ll learn blur backgrounDs in software

create shallow 
focus effects in 
photoshop
Shots don’t have to be sharp all the way 
through – here’s how to make a shallow 
depth-of-field effect using software

an iMage with an isolated 
point of sharp focus can be more 
intriguing and aesthetically pleasing 
than one that’s sharp from front to 
back, but if you’ve already taken the 
picture, you can’t dial in a large 
aperture remotely and reshoot the 
image in a different way! 

if you’re a compact user, you don’t 
even get the option of shooting a 
narrow depth-of-field effect in the 

first place, because the very small 
sensor and short focal lengths 
always give you a shot that’s sharp 
right the way through. blurred 
backgrounds can be impossible to 
achieve with a compact, but with this 
technique, you can recreate them. 
what’s more, it uses the standard 
gaussian blur filter found in elements 
and photoshop, so it works with any 
version of the software.

blur the pic. go to Filter ➔ Blur ➔ 
Gaussian Blur and in the dialogue box, use 
a Radius of around 10 pixels (try a little more if your 

image is bigger than our 6 megapixel example here). keep 
Preview ticked and you’ll see how blurred the image becomes, 
and when you’re happy, click OK.  

start copy the layer. open your picture into 
photoshop or elements and then hit Ctrl+J three times to 
end up with four copies of the original. go to Window ➔ 

Layers and you’ll see them stacked up on top of each other in the 
Layers palette. switch off the top two layers by clicking on the 
‘eye’ icons and then click on Layer 1 to make it active. 

1 2

“ Blurred backgrounds can be impossible 
to achieve with a compact camera ”

start iMage lighthouse.jpg
taken using a compact camera, our shot is sharp all 
the way through, but we want to isolate the focus 
to give a more arty look to the picture.

final iMage
the depth-of-field extended 
from front to back on our 
original shot, but we’ve 
restricted it to the rocky 
foreground details to change 
the mood of the pic.

step-by-step

www.photoanswers.co.uk

aperture f/5.6
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warM up the background. 
create another adjustment layer, and 
again choose Levels. this time we’re going 

to adjust the whole image, so tweak the contrast using 
the RGB sliders, and then select the individual Red and Blue channels as 
before and move them a little to warm up the whole image. 

reMove the sky. click on Layer 1 Copy, switch on the ‘eye’ 
icon, and apply Gaussian Blur again, this time with a Radius of 
around 5 pixels. now switch off all the other layers to avoid 

confusion, and pick the Eraser tool. use a soft-edged brush around 100 
pixels in size, and erase the sky and the lighthouse, leaving the rocky 
skyline and foreground in place.

warM-up the foreground. 
before closing the adjustment layer, 
click on the Channel box, select Red, and move the middle slider 

a little to the left. now select the Blue channel, and move the middle 
slider a touch to the right. this warms up the colours in the rocks. click 
OK (or just leave your adjustment layer, if this is not an option) . 

create an adjustMent layer. click the Adjustment 
Layer icon and select Levels from the list. if you can OK the 
adjustment, do so, and then hold Alt and click on the line 

between the layers to clip the adjustment layer to Layer 1 Copy 3. now 
double-click on the adjustment layer thumbnail and move the Input 
Levels sliders under the histogram to improve the contrast. 

7

93

5

8

104

6
enlarge the foreground. hit Ctrl+T to enter Transform 
mode, and after creating a little bit of room (Ctrl+Minus), hold 
Shift (or make sure the Constrain Proportions box is ticked in the 

options bar) and drag out a corner handle slightly. this will enlarge the 
foreground rocks and cover any blurred version of the same part of the 
scene. when you’re happy, hit Return to confirm the transform. 

sharpen the detail. if you now switch on the other layers, 
you’ll see that the focus appears to recede as the details get 
further away, and to really emphasise this, we’re going to sharpen 

the foreground. hit Ctrl+J to copy the foreground layer, and go to Filter ➔ 
Sharpen ➔ Unsharp Mask (Enhance ➔ Unsharp Mask in elements). use 
settings of 150, 1.0 and 0 and you’ll see the rocks snap into sharp focus. 

square up. we just need to straighten up a touch  so hold 
Alt, click on the fly-out arrow at the top right of the Layers 
palette, and select Merge Visible. release Alt after you’ve 

done this, and a new layer will appear, containing everything you’ve 
done. hit Ctrl+T and then, while holding Ctrl, drag out the bottom right 
corner until the lighthouse is vertical. hit Return and the job is done!

cut out the foreground. switch on Layer 1 Copy 2 at 
the top of the stack, and switch off all the other layers. with a 
hard-edged Eraser (hold Shift and tap the right square bracket 

key to harden the brush), remove everything except the rocks occupying 
the bottom half of the picture. take care with the top edge, and use a 
small brush to make the cut-out as accurate as possible.

subscribe to digital photo today

for the latest offers visit the website:
www.greatMagazines.co.uk/dp

learn More skills

wHat you need photoshop or elements 
wHat you’ll learn blur backgrounDs in software

if you’ve enjoyed these depth-of-field based projects and want to 
know more about using your camera and software to create 
amazing images, then Digital Photo is the magazine for you! every 
issue is packed with practical shooting projects and smart ways to 

enhance your shots in popular software like photoshop or 
elements. learning is easy thanks to the free monthly video 
lesson cd, and you can subscribe for far less than the cover price 
using the link below. get involved and your pics will thank you! 
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